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Oracle Eloqua Sales Tools for Microsoft
Outlook

Oracle Eloqua Sales Tools for Microsoft Outlook is an add-in for Microsoft Outlook. It

provides users with easy access to both Profiler and Engage straight through

Microsoft Outlook's email composer, and comes packaged with similar capabilities as

the native web and mobile versions of the (responsive) Profiler and Engage. This

provides a seamless and consistent experience for sales users that work across a

range platforms and devices. Sales users who leverage Microsoft Outlook as their

primary tool to interact with key prospects on a day-to-day basis have the ability to

gain rich insight in cross-channel buyer behavior, and access to marketing approved

email templates without having to leave their email platform of choice.

Oracle Eloqua Sales Tools for Microsoft Outlook is provided free of charge as an add-

in to all Engage customers. The use of Profiler is supported but optional for customers

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=Profiler
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=Engage
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with both Engage and Profiler licenses. Emails are sent through Microsoft Outlook,

and are created and visualized in Engage for sales users to review and track. An email

activity is created for each recipient.

Below is an overview of the features that can be accessed with the add-in:

Oracle Eloqua Profiler Oracle Eloqua Engage
Analyze Digital Body Language by drilling
into cross-channel buyer activities
including email open/clicks, form
submission, web activity and more.

Engage with Insight leveraging pre-
approved marketing templates or
personal emails without having to leave
the Outlook email composer.

Browse Lead Scores to identify the right
opportunity to chase for your buyers and
prospects.

Track Every Interaction by enabling
tracking on Outlook Emails, whether
you’re using a marketing template or
writing a more personal email.

Set-up Web Alerts and get notified once a
key prospects visits your website

Leverage Marketing Approved Content
by having access to email templates
straight within Microsoft Outlook.

Learn more by watching the video!

https://www.youtube.com/playlist?list=PLw7GyH-Hj8cNDsCqzAFC-GRuW4sxaKJo2
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Frequently asked questions

The following are some of the questions most often asked about Oracle Eloqua Sales

Tools for Microsoft Outlook.

Q. Are there any additional costs to use the Sales Tools for Microsoft Outlook

add-in?

A. No, the Microsoft Outlook add-in will be provided free of charge for Oracle Eloqua

Engage customers.

Q. How do I install the Oracle Eloqua Sales Tools for Microsoft Outlook?

A. Engage users can install the add-in on their own. IT administrators can also install

the add-in for users in bulk. For information on mass deployment, contact My Oracle

Support.

Q. What license do I need to access the Sales Tools for Microsoft Outlook add-

in?

A. Sales users require, at a minimum, the Oracle Eloqua Engage and the Eloqua Sales

Tools for Microsoft Outlook licenses. To access Profiler from the Microsoft Outlook

add-in, sales users will also need the Profiler license.

Q. Are emails sent through Microsoft Exchange or Eloqua (Engage)?

https://support.oracle.com/
https://support.oracle.com/
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A. Emails are sent through the customer's Exchange server. The add-in calls Eloqua to

create a deployment and provide the email content, that is then sent by the customer's

exchange sever. Emails are visualized in Engage for sales users to review and track. An

email activity is created for each recipient.

Q. What are the differences between Engage and the Sales Tools for Microsoft

Outlook add-in?

A. The two products have a very similar feature set, with a handful of key differences.

Functionality Engage Outlook
Tracked emails

Contact creation

Contact lookup

Preview an email prior to send

Field merges

Inserting additional field merges, not included in email templates

Access to templates

Support for protected templates created by marketing

Eloqua Profiler embedded / accessible

Plain text email

Contact validation:
      Unsubscribed

      Bouncebacks

      Master exclude

      Contact security

User able to save emails as templates / share with other users
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Functionality Engage Outlook
Cloud content

Insertion of attachments from Eloqua

SSO

Localized

Restrict number of contacts per email send

User upload of images to Eloqua

Q. When I open Microsoft Outlook, a dialog message appears about using the

"Send Pictures With Document" setting. What does this mean?

A Microsoft Outlook setting can be used to embed images in a message. This setting

may be on or off depending on your version of Microsoft Outlook and could be turned

on or off by you or your organization.

This setting may prevent adding the Oracle Eloqua tracking pixel when you send a

tracked email message.

You can continue to use the Microsoft Outlook add-in with this setting turned on. But

we recommend testing to ensure that tracking is not impacted by your particular

Microsoft Outlook version and configuration. If you want to turn off the setting, refer

to this support article from Microsoft.

Q. Is there a maximum number of recipients?

A. Yes, the maximum number of recipients that can be tracked is 100. Administrators

cannot manage this maximum for the Microsoft Outlook add-in.

https://support.microsoft.com/en-us/topic/inline-images-may-display-as-a-red-x-in-outlook-704ae8b5-b9b6-d784-2bdf-ffd96050dfd6
https://support.microsoft.com/en-us/topic/inline-images-may-display-as-a-red-x-in-outlook-704ae8b5-b9b6-d784-2bdf-ffd96050dfd6
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Q. Is the hide in mobile feature supported in Sales Tools for Microsoft Outlook?

A. No. If a template is created in Eloqua that includes a hidden content, and a user

sends the template via Sales Tools for Microsoft Outlook, then that email does not

hide the content.

Q. Are locked blocks supported in Sales Tools for Microsoft Outlook?

A. Locked blocks are not supported in the Oracle Eloqua Sales Tools for the Microsoft

Outlook add-in. In the Microsoft Outlook add-in, sales users will be able to edit the

locked block styling.

Q. Is Microsoft Office 365 supported?

A. Microsoft Office 365 Professional Plus (ProPlus) is supported. This version of Office

365 still allows users to install the most recent version of Microsoft Outlook on their

local machines. View the Microsoft documentation for more information. Web-based

versions of Outlook that are a part of Office 365 are not supported.

Q. I see that you support Microsoft Office 365 for Exchange Server, does this

mean you support Office 365?

A. The Office 365 version of Exchange Server can be used to connect with Outlook

2019 and is therefore supported. The only version of the Office 365 product line that is

supported is Office 365 ProPlus.

https://docs.oracle.com/en/cloud/saas/marketing/eloqua-user/index.html#cshid=HideInMobile
https://docs.microsoft.com/en-us/deployoffice/about-office-365-proplus-in-the-enterprise
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Q. If emails are sent using my Exchange Server, how would bouncebacks be

tracked?

A. If a sales user sends an email to a contact using the add-in in Outlook, and that

email bounces, that bounceback is not currently tracked back to Eloqua.

Emails sent using Engage, which are sent through Eloqua, will track bouncebacks. This

is an important consideration when evaluating which application to use.

Q. Do emails sent through Microsoft Outlook appear in Engage?

A. Yes, emails sent from Microsoft Outlook that are tracked with the add-in will appear

inside the sent list in Engage.

Q. Is the add-in localized?

A. Yes, it is localized into the same languages that are supported by the Sales Tools

suite. See language support for a list of those languages.

Q. How many tracked emails can users send at a time?

A. Users are limited to 100 tracked emails that can be sent at one time. Additionally, if

you configure the send limit in the Engage app, you can also limit the number of sales

emails that your reps can send to the same contact over a period of time.

Q. Why are locked sections in email templates not supported in Microsoft

Outlook?

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/Help/General/LanguageSupport.htm
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A. Microsoft Outlook does not support locked regions within an email. When users

insert an email template, all sections of the template will be editable. Customers

should start to audit their existing templates and plan accordingly.

Q. Is sign on with SSO supported?

A. Yes, after installing the add-in, users will login to the standard Eloqua login screen

with their credentials and can choose Sign in with SSO or another account.

Q. How can I avoid email opens when I view a sent message in Outlook?

A. The sent message includes a tracking pixel. Once the message is in the Sent folder,

Sales Tools for Microsoft Outlook removes its tracking pixel to avoid any artificial

inflation of metrics due to opening a message in your Sent folder. However, Microsoft

Outlook caches the first message in the Sent folder for approximately five minutes or

until you perform another action in Outlook such as opening a new Compose window.
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Installing Oracle Eloqua Sales Tools for
Microsoft Outlook

Oracle Eloqua Sales Tools for Microsoft Outlook is an add-in for Microsoft Outlook. It

provides users with easy access to both Profiler and Engage straight through

Microsoft Outlook's email composer, and comes packaged with similar capabilities as

the native web and mobile versions of the (responsive) Profiler and Engage.

Z Important: Engage end users can install the add-in on their own. IT

administrators can also install the add-in for users in bulk. For information on

mass deployment, contact My Oracle Support.

Prerequisites

l You must have the Eloqua Engage and the Eloqua Sales Tools for Microsoft Outlook

licenses. To access Profiler from the Microsoft Outlook add-in, you must also have the

Profiler license.

Prior to installing Oracle Eloqua Sales Tools for Microsoft Outlook, ensure that your

system meets the following requirements:

Microsoft
Outlook

l Microsoft Outlook 2010 SP1 / Microsoft Outlook 2010 SP2

l Microsoft Outlook 2013 / Microsoft Outlook 2013 SP1

l Microsoft Outlook 2016

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=Profiler
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#CSHID=Engage
https://support.oracle.com/
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l Microsoft Outlook 2019

l Microsoft Outlook for Microsoft 365

Operating
system

l Microsoft Windows 7 SP1

l Microsoft Windows 8.1 and higher

l Microsoft Windows 10

ëNote: Microsoft Outlook for Mac OS is not currently supported.

Microsoft
Exchange
Server

l Microsoft Exchange Server 2010

l Microsoft Exchange Server 2013

l Microsoft Exchange Server 2016

l Microsoft Office 365

Mailbox
storage

l OST in Cached Exchange Mode (default mode)

l PST

Microsoft
.NET
Framework

v.4.5 must be installed on the computer where add-in will be used. It is
installed by default for all mentioned OS versions except Windows 7

Default
email
application
(Optional)

Users can open a compose window in Microsoft Outlook when clicking on
a contact's email address within Profiler. In order for a compose window
to open in Microsoft Outlook, users must configure Microsoft Outlook to
be the default email application on their machine.

You can search for and install new apps in the Oracle Cloud Marketplace

(https://cloudmarketplace.oracle.com/marketplace/en_US/homePage.jspx).

To install Oracle Eloqua Sales Tools for Microsoft Outlook:
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1. Ensure Microsoft Outlook is not currently running on your machine. If it is open, you will be

prompted to close it before installing the add-in.

2. Follow one of the URLs below, depending on your Windows operating system:

Windows 32-bit:

https://cloudmarketplace.oracle.com/marketplace/app/SalesToolsMicrosoftOutlookWin32

Windows 64-bit:

https://cloudmarketplace.oracle.com/marketplace/app/SalesToolsMicrosoftOutlookWin64

3. Click Get App.

4. Follow the instructions in the installation wizard, then click Finish.

5. Open Microsoft Outlook.

6. Sign in to Oracle Eloqua using your company name and credentials. If your company

leverages single sign-on, click Sign in with SSO or another account. For more details, see

Signing in to Eloqua.

https://cloudmarketplace.oracle.com/marketplace/app/SalesToolsMicrosoftOutlookWin32
https://cloudmarketplace.oracle.com/marketplace/app/SalesToolsMicrosoftOutlookWin64
https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/Help/Administration/Tasks/SigningInToEloqua.htm
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ëNote: Signing in is required only for the first run of the Oracle Eloqua Sales Tools

for Microsoft Outlook add-in.

¤ Tip: If you are using Microsoft Edge or Sales Tools for Microsoft Outlook to access

the Oracle Eloqua sign in page in an iframe, an addition should be made to trusted

sites. Add https://*.eloqua.com and the URL of the site where the login page

(Oracle Eloqua and/or Sales Tools) is being iframed. The browser must be closed fully

and restarted before the change is recognized. For additional information, see this

Topliners post about Oracle Eloqua login enhancements.

https://community.oracle.com/docs/DOC-1020186
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The Oracle Eloqua Sales Tools for Microsoft Outlook add-in is now installed and visible

in the ribbon.
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Accessing Oracle Eloqua Sales Tools for
Microsoft Outlook

This topic outlines how to access the Oracle Eloqua Sales Tools for Microsoft Outlook

add-in once it has been installed.

Prerequisites

l Oracle Eloqua Sales Tools for Microsoft Outlook must be installed.

l You must have the Eloqua Engage and the Eloqua Sales Tools for Microsoft Outlook

licenses. To access Profiler from the Microsoft Outlook add-in, you must also have the

Profiler license.

To access Oracle Eloqua Sales Tools for Microsoft Outlook:

1. Open Microsoft Outlook.

2. Click Options > Sign In from the main ribbon, or open an email and click Sign In.

3. Sign in to Oracle Eloqua using your company name and credentials. If your company

leverages Single Sign-On, click Sign in with SSO or another account.
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ëNote: Signing in is required only for the first run of the Oracle Eloqua Sales Tools

for Microsoft Outlook add-in.
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Sending a tracked email

Use Oracle Eloqua Sales Tools for Microsoft Outlook to send a tracked email directly

through Microsoft Outlook. Eloqua is called so that sent messages are created and

displayed in Engage's sent list for sales users to review and track. Email activity is

created for each recipient.

Prerequisites

l Oracle Eloqua Sales Tools for Microsoft Outlook must be installed.

l You must have the Eloqua Engage and the Eloqua Sales Tools for Microsoft Outlook

licenses. To access Profiler from the Microsoft Outlook add-in, you must also have the

Profiler license.

ëNote: Tracking is enabled by default when the add-in is installed. Your

organization may desire tracking on all new emails to be off by default. For

example, you may want a sales representative to deliberately choose to track

specific emails and require them to check the tracking box. You can configure

whether this option is enabled by default or not via a Microsoft Windows Group

Policy or Microsoft System Center Configuration Manager (SCCM) deployment.

For more details, log in to My Oracle Support (https://support.oracle.com) and

create a service request.

To send a tracked email using Oracle Eloqua Sales Tools for Microsoft Outlook:

https://support.oracle.com/
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1. Open a new email in Microsoft Outlook. When tracking is enabled, the Tracking On box is

checked and Track Email option in the ribbon is selected. Users can toggle tracking on or

off for individual email messages. When the Tracking On box is cleared, the message is sent

as a personal email and is not tracked.

¤ Tip: To automatically enable tracking for all new emails, in the main ribbon,

navigate to Options > Settings and check Always track new emails.

2. Add your recipients by manually entering email addresses or searching Oracle Eloqua

contacts.
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Z Important: The maximum number of recipients that can be tracked is 100.

l The add-in automatically verifies if manually entered recipients are Oracle Eloqua contacts. If they

are not contacts, a Fix Validation Issues link is displayed. Click the link to add them as contacts

before sending the email. You can also remove the recipients if you do not want to add them as

contacts.
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l To search for Oracle Eloqua contacts, click Search Contacts in the ribbon.

Search contacts by name, email address or title. Using Microsoft Outlook's standard contact search

(by clicking To... or Cc...) will not search Oracle Eloqua contacts. Click Add Contact to add them to

your recipient list. At least 3 characters must be specified to search.

Z Important: Contact match and search is based on the contacts you have access to

based on your Oracle Eloqua user permissions.

3. Write a personal email or select an Oracle Eloqua template.

l To select a template, click Select Template in the email ribbon. You can search templates by its

name. At least three characters must be specified to search. Narrow the search by selecting

specific email groups. Sort templates by name, creation date, or modified date. Click Apply to use

the selected template in your email and override the current subject and body content (if any) of

your email.
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l Templates with cloud content cannot be used but they are still searchable. The Apply button will

be disabled when these templates are selected.

l Microsoft Outlook does not support locked regions within an email. Once you select a template, all

sections will be editable.

l After a template is selected, the contacts are validated to check if they have the required field

merges. If not, you will be prompted to add the missing field merges before sending the email.

l You cannot use any files (pictures, documents, and so on) as Microsoft Outlook email attachments

because they are not accessible from the add-in. However, you can add attachments to the email

from your machine. These attachments are not tracked.

4. Click Preview Email. The preview allows you to take a peek at how the email will look like for

the first recipient in the list, including any field merges. In order to preview the email, the

first recipient must be validated and the subject cannot be empty. Close the preview and

make any necessary edits.
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5. Click Send. Oracle Eloqua Sales Tools for Microsoft Outlook validates recipients to check for

any problems and will prompt you to fix any issues that are found.

6. After validation is complete, tracking parameters are added to the email. Click the Cancel

Sending link if you want to stop the email from being sent during this process. As an email

is sent to each contact, they are removed from the To line.

Your email is sent to your recipients and appears in your Microsoft Outlook Sent Items

folder. It is automatically assigned a Tracked by Eloqua category. Email sent metrics

are also displayed. Learn about sent email metrics.

Z Important: The sent message includes a tracking pixel. Once the message is

in the Sent folder, Sales Tools for Microsoft Outlook removes its tracking pixel to

avoid any artificial inflation of metrics due to opening a message in your Sent

folder. However, Microsoft Outlook caches the first message in the Sent folder
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for approximately five minutes or until you perform another action in Outlook

such as opening a new Compose window.
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Creating new contacts using the Eloqua
Sales Tools add-in for Microsoft Outlook

As a sales user, you can use Oracle Eloqua Sales Tools for Microsoft Outlook to create

new Eloqua contacts for your leads.

Prerequisites

l Oracle Eloqua Sales Tools for Microsoft Outlook must be installed.

l You will need permission to manage contacts, which an administrator needs to enable for

you. An administrator is an Eloqua user who manages users and security groups.

To create a contact using Oracle Eloqua Sales Tools for Microsoft Outlook:

1. Open a new email in Microsoft Outlook, make sure the Tracking On box is checked, and

type your new contact's email address. You will see a Fix Validation Issues warning appear

above the To: field.

2. Click the Fix Validation Issues warning to open the Create New Contact window. This will

allow you to input additional contact details. The field selection is based on your selection in

the View drop-down menu.
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ëNote: You can use the View drop-down menu to change the selection of contact

fields available to you. Your selection will depend on what views your administrator

sets up. Administrators create and share contact views with sales rep using existing

Eloqua contact view management and access settings.

3. Click Add Contact when finished. Your tracked email to your new Eloqua contact is ready to

be sent! 

ContactViewsSalesTools.htm
ContactViewsSalesTools.htm
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Viewing email performance using
Microsoft Outlook

Once a tracked email is sent using Oracle Eloqua Sales Tools for Microsoft Outlook,

email metrics, such as opens and clicks, are collected. The metrics are available when

viewing the email in the Microsoft Outlook Sent Items folder. These metrics are also

available in Engage, and in Insight for marketing administrators.

To view sent email performance:

1. In Microsoft Outlook, open your sent email folder.

2. Search for the tracked email that you sent. Tracked emails have their own category.
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3. Open the email. The performance metrics are displayed in the message banner.

Report metrics

This report captures the following metrics.

Metric Description
Total Opens The number of times an email was opened. This includes

multiple opens by the original recipient or forwarded
recipient.

Oracle Eloqua counts an email as opened if the recipient
loaded the tracking pixel image contained in the email or
clicked a link in the email. For more information, see
Calculating email opens.

Last Open The most recent date and time the email was opened.
Total Clicks The total clickthroughs. This includes multiple clicks by the

same recipient. System Action links are not tracked.

https://docs.oracle.com/cloud/latest/marketingcs_gs/OMCAA/index.html#cshid=CalculatingEmailOpens
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When reviewing metrics, note the following:

l Open statistics are only captured if the email recipient has the display images setting

enabled for the email.

l When the email is forwarded or replied to, and the subsequent email is opened, the opens

count towards the total opens.

l The enable tracking feature does not impact the behavior of Microsoft Outlook.
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Validation issues

Validating recipients involves checking all email recipients against the Oracle Eloqua

contact database.

The validation process is always triggered automatically in the following cases:

l When a recipient is manually added to the recipient list

l When the contact lookup dialog is closed

l When an email is previewed

l When an email is sent

The validation process determines whether email recipients match certain conditions

and all validation issues must be fixed in order to send the tracked email:

l Are the recipients Oracle Eloqua contacts? To fix the issue, add recipients as contacts.

l Is all the information required for field merges in the selected template complete? To fix the

issue, add the missing contact information required for the field merges in the template.

l Can the email be sent to all contacts? For example, are contacts subscribed and do they have

valid email addresses? To fix the issue, remove any contacts who are excluded.

A green check mark displays after all validation issues have been resolved and the

tracked email can be sent.

After clicking send, additional validation occurs to ensure that send limits haven't been

exceeded. If they have, you will have to remove the contact.
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Accessing Profiler

Oracle Eloqua Profiler can be accessed in Microsoft Outlook. With Profiler you are able

to view the contact details for a potential client, their activities, their lead score value,

and so on. Viewing a contact's information can help you decide what type of email to

send to them.

Prerequisites

l Oracle Eloqua Sales Tools for Microsoft Outlook must be installed.

l You must have the Eloqua Engage and the Eloqua Sales Tools for Microsoft Outlook

licenses. To access Profiler from the Microsoft Outlook add-in, you must also have the

Profiler license.

To access Profiler in Oracle Eloqua Sales Tools for Microsoft Outlook:

1. Open Microsoft Outlook.

2. Open or select a message with the contact you want to view in Profiler.
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3. From the Oracle Eloqua ribbon, click Show Profiler.

Profiler automatically searches for all contacts in your recipient list. If there is only one

contact, their information is displayed. If you are launching Profiler from an email

without any recipients listed, the search contacts screen opens to help you quickly find

the contact you are looking for.
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